
NCH Software
Express Points Presentation Software

This user guide has been created for use with

Express Points Presentation Software Version 1.xx

©NCH Software



Technical Support

If you have difficulties using Express Points Presentation Software please read the applicable 
topic before requesting support. If your problem is not covered in this user guide please view 
the up-to-date Express Points Presentation Software Online Technical Support at www.nchsoftware.com/presentation/support.html

. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions

If you have any suggestions for improvements to Express Points Presentation Software, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 
Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/presentation/support.html
www.nch.com.au/suggestions/index.html
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Overview

Thank you for installing Express Points Presentation Software for presentation. Use Express 
Points Presentation Software to create, view, show and print presentation documents quickly. 
Express Points presentations consist of templates and slides that allow the user to organize 
and present various information (e.g., text, pictures, audio, video, and graphics shapes) in a 
professional manner. 

Features  

● Create and show presentation documents
● Support various slide items: text, graphics shapes, images/cliparts, audio and video
● Import popular image, audio and video formats
● Record narration to add it to a presentation
● Harness the power of drag and drop - position, resize and rotate your slide items
● Easily layer slide items
● Easily format and align your text
● Quickly change color and line style of graphics shapes
● Provides various preset layouts to expedite presentation creation
● Edit templates to make a slide's style consistent
● Provide more than 20 transitions to make your presentation vivid
● Import Microsoft PowerPoint Presentation(.pptx)

System Requirements  

● Windows XP / Vista / 7 / 8
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Getting Started

When first starting Express Points Presentation Software, you will be greeted by the welcome 
dialog, where you can select to either: 

● Create a new project
● Open an existing project file
● Read the Getting Started guide

Selecting 'Create new project' will open the main window, where you will spend most of your 
time refining your presentation. 

While you refine your presentation, you can click the Slideshow button on the main window 
toolbar to bring up a full screen preview to check the content and transitions you have created 
so far. 

When you have finished designing your presentation, click the Print button on the main 
window toolbar to bring up the print preview dialog to preview and print it. 
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Main Window Reference

Toolbar 

The main window's toolbar contains useful buttons for frequently occurring operations you 
will be performing. 

The toolbar tabs are used in the following ways: 

The File Tab 

Contains most options for loading, saving, and closing your current project. It also 
contains options for printing and for opening the recent files list. See: Menu reference for 
more information on each action. 

The Home Tab  

Contains several of the New, Open, and Save buttons from the File tab, as well as 
buttons for: 

●  New a slide with a default layout or a preset layout by opening the Preset Layouts
dialog 

●  Opening the Preset Layouts dialog 
● Adding a text box
● Adding graphics shapes
● Adding images/pictures
● Adding ClipArt
● Adding audio
● Adding video
● Transition: Express Points Presentation Software allows you to set transition 

effects and their duration
●  Slideshow: Express Points Presentation Software allows users to create 

slideshow presentations. When the slideshow is started, the program will enter full 
screen mode. 

●  Opening the Print Preview dialog 
●  Opening the General Options dialog 

The Edit Tab 

Contains buttons for interacting with objects and the clipboard, including: 

● Cut, Copy, Paste
● Delete
● Undo and Redo
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● Bring to Front: bring a slide object to the front of a group of stacked slide objects.
● Bring Forward: move a slide object up one placement toward the front of the 

stacking order.
● Send Backward: send a slide object one placement toward the back of the 

stacking order.
● Send to Back: send a slide object to the back of a group of stacked slide objects.

The View Tab 

Contains buttons to show or hide some panels and switch between the normal slide view 
and the master page view: 

● Slide List: show or hide the Slide Thumbnail List.
● Normal: switch to normal slide view in Slide Editor.
● Slide Masters: switch to master page view in Slide Editor.
● Attributes: show or hide the attributes panel.
● Ruler: show or hide rulers in the slide editor.
● Notes: show or hide the text edit panel of slide notes.

The Suite Tab 

Contains buttons to install and launch other recommended NCH software products: 

● BoltPDF Printer: It makes creating PDF files easy.
● ClickCharts: Create a visual representation of a process, organization, mind map 

or other diagrams and sequences.
● PhotoStage: Share your favorite photos with family and friends in an interesting 

way. Create a video slideshow from photos fast with this easy-to-use program.
● VideoPad: It is a full featured, easy-to-use video editing application which lets you 

edit video files (or create professional videos) on your computer fast.
● WavePad: It's a must-have for anyone who needs to do anything serious with 

audio (e.g. trimming or processing recordings).
● ExpressAccounts: It is a full accounting package to track all income and 

expenses, generate financial statements and assist in preparing tax returns.

The Slide Thumbnail List  

The list is located directly beneath the toolbar, on the left-hand side. It shows all slides in your 
presentation for the type of slide view selected, and allows you to add, delete and hide slides 
from the right-click menu. Select a slide to display it in the slide editor by clicking it, and 
rearrange slides by dragging them to new positions in the slide panel. You can change the type 
of slide view by selecting "Normal" or "Master Page" from the drop menu at the top of the 
panel. 
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The Slide Editor  

This is the main window area directly beneath the toolbar, in the middle, where you edit and 
refine the current slide of the presentation. 

This editor is where text, graphics shapes, images and audio objects  will be added to your 
presentation, which you can position, resize, rotate and change layer order to achieve your 
desired look. 

The Attributes  

Several types of panels will appear to the right of the slide editor. These panels contain many 
options for interacting with specific elements of your project, such as the: 

●  Fill Properties panel. 
●  Line Properties panel. 
●  Color Schemes panel. 

The Slide Notes Editor 

This is the main window area directly beneath the slide editor, on the bottom, where you can 
add and edit notes for the current slide of the presentation. The notes can give you some 
reminder when you present your slides to your audience if you have multiple display devices. 
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Menu Reference

The menus are hidden from the main interface by default when you install Express Points 
Presentation Software. To show the menus, click the small arrow to the left of the Help icon in 
the upper right corner of the interface.

File Menu 
New (Ctrl + N) 
Creates a new Express Points Presentation Software project

Open (Ctrl + O) 
Loads an existing Express Points Presentation Software project

Save (Ctrl + S) 
Saves your Express Points Presentation Software project

Note: Express Points Presentation Software will automatically save your project to a 
temporary file every 100 seconds to let you recover it in abnormal cases.

Save As (Ctrl + Shift + S)  
Saves your Express Points Presentation Software project as a new file

Close 
Closes the current presentation project.

Page Setup 
Opens the Page Setup  dialog to set the page size and orientation of all slides in the 
presentation. 

Slideshow (F5)  
Enter full screen to show the presentation from the first slide that is not hidden.

Export to Video... 
Opens the Video Output Setup dialog, to select the destination device and format and 
export your Express Points Presentation Software project to a video file. You can also 
upload the video onto popular media websites like YouTube, Facebook and Flickr. There is 
a help page for every destination type (access them by pressing the Help button or 
following any "What's this?" link). 

Export to PDF... 
Opens the Preview for Exporting PDF dialog, to export your Express Points Presentation 
Software project to a PDF file specified by you. 

Print (Ctrl + P)  
Opens the Print Preview dialog, to print your Express Points Presentation Software project 

Recent Files 
A list of your recently opened and saved Express Points Presentation Software projects

Exit (Alt+F4) 
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Closes the program

Object Menu 
Add Text  
Adds a text object to the current slide.

Add Shape 
Adds a graphics shape(rectangle, ellipse, trapezoid, parallelogram, line or curve) to the 
current slide.

Add Image...  
Adds an Image object from a disk file to the current slide.

Add ClipArt... 
Adds an Image object from NCH's ClipArt Library online to the current slide.

Add Audio... 
Allows you to add audio from disk file to the current slide. You also can record a narration to 
add it to the current slide.

Add Video...  
Allows you to add video from disk file to the current slide.

Bring to Front 
Bring a slide object to the front of a group of stacked slide objects.

Bring Forward 
Move a slide object up one placement to the front in the stacking order.

Send Backward  
Send a slide object one placement to the back in the stacking order.

Send to Back  
Send a slide object to the back of a group of stacked slide objects.

Edit Menu 
Cut (Ctrl + X) 
Copies and deletes the selected item(object or slide).

●   Object: 
The selected object will be cut if an object is selected.
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●  
Slide: 
The current slide will be cut if no objects are selected and the number of slides is 
more than one.

Copy (Ctrl + C)  
Copies the selected object to the clipboard

●   Object: 
The selected object will be copied to the clipboard if an object is selected.

●  
Slide: 
The current slide will be copied to the clipboard if no objects are selected.

Paste (Ctrl + V) 
Pastes information from the clipboard:

●   Object: 
Text, graphics shape, image, audio, or video, including settings for those objects

●  
Slide: 
Pasting the whole slide. If the slide is a normal slide, its template is possible to be 
added into the presentation project.

Delete (Delete) 
Deletes the selected item(object or slide)

●   Object: 
The selected object will be removed if an object is selected.

●  
Slide: 
The current slide will be removed if no objects are selected and the number of slides 
is more than one.
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Undo (Ctrl + Z) 
Erases the last change done to the document reverting it to an older state.

Redo (Ctrl + Y) 
Redo the last undo action.

Options Menu 
Options... 
Opens the program options. See: General options 

Help Menu 
Contains assorted help topics 
Note that you can open the help documentation by pressing F1 on your keyboard  
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Keyboard Shortcuts

The following list shows shortcuts for the most common tasks used in Express Points 
Presentation Software:

●  Open an existing project Ctrl+O 
●  Create a new project Ctrl+N  
●  Save your project Ctrl+S 
●  Save your project as a new file Ctrl+Shift+S  
●  Print Ctrl+P 
●  Cut Ctrl+X 
●  Copy Ctrl+C  
●  Paste Ctrl+V 
●  Delete Delete 
●  Undo Ctrl+Z  
●  Redo Ctrl + Y 
●  Zoom in Ctrl+'+' 
●  Zoom out Ctrl+'-' 
●  Slideshow F5 
●  End slideshow Esc 
●  Help menu F1 
●  Exit Express Points Presentation Software Alt+F4 
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Flickr Authorization

This desktop application can make it easy and convenient to upload your photos or videos to 
Flickr. However, it needs your permission before you use it. If you click the Authorize... button, 
it will connect to internet and open the authorizing webpage of Flickr. 

After you have finished the authorization, please click the Ready button to tell the application 
that the process of authorization is finished. And then you can upload your photos or videos to 
Flickr. 

Flickr Authorization 

If this application has the authorization of a Flickr's user, the Authorize... button will be 
disabled and the Remove Authorization  button will be enabled so that you can delete the 
authorization. Otherwise, you click the Authorize... button to authorize this application for 
uploading photos or videos to Flickr. 
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Software License Terms

1)  The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. 
Installation of this software and any software bundled with or installed-on-demand from this 
software is licensed only in accordance with these terms.

2)  
By installing, using or distributing this software you, on your own behalf and on behalf of 
your employer or principal, agree to be bound by these terms. If you do not agree to any of 
these terms, you may not use, copy, transmit, distribute, nor install this software - return it 
to the place of purchase within 14 days to receive a full refund.

3)  
This software, and all accompanying files, data and materials, are distributed "as is" and 
with no warranties of any kind, whether express or implied except as required by law. If you 
intend to rely on this software for critical purposes you must test it fully prior to using it, 
install redundant systems and assume any risk.

4)  
We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for 
all claims is limited to receiving a full refund for the amount you paid for the software.

5)  
You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You agree to indemnify us from 
any claims relating to such unauthorized use.

6)  
You may copy or distribute the installation file of this software in its complete unaltered 
form but you may not, under any circumstances, distribute any software registration code 
for any of our programs without written permission. In the event that you do distribute a 
software registration code, you will be liable to pay the full purchase price for each location 
where the unauthorized use occurs.

7)  
Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage data and email addresses in limited 
circumstances.

8)  
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The contract arising out of this agreement is governed by the laws and courts of the 
Australian Capital Territory.
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Concepts - Objects

Objects are components of a slide including text, graphics shapes, images, audio and video. 
You can place any object onto a slide in a presentation project from the main window. Click the 
object if it is not active. You can tell that a text object is active when you see 8 small binding 
boxes around the edges of the text box. Objects can be positioned, resized and rotated. Also 
you can set fill color and line style of some objects. Furthermore, you can change their layer 
order. 

You can use your mouse to right-click inside the project viewer to present several options for 
objects. These options will have similar behavior to the Cut, Copy, Paste, and Delete buttons 
found in the edit menu. See: Menu reference 

Graphics Shapes 

A shape is a geometric object such as a circle, rectangle, line or curve. Text and 
corresponding styling information can also be attached to a shape. 

To add shape to your slide, click the Add Shape button and select the shape type on the main window toolbar
. Next, add the shape on your slide by clicking and dragging a box; 

when you release the mouse your shape will appear. You can format the shape using the 
property panel on the right. Also, you can add text by selecting Edit Text from the right-click 
menu. A rich text editor will open. See: Text Edit Dialog 

Image  

Each image object contains a single image. If the originally loaded image contains an alpha 
channel, the image object will appear transparent. 

To add images to your slide, click the Add Image  button on the toolbar. The Select Image 
window will open. Navigate to and select the photo that you would like to add, then click the 
Open button. You can select, move, rotate, and resize your image object by dragging it, or 
change other properties using the right panels. 

You can also click the Add ClipArt button on the toolbar to add an image from NCH's 
clipart library online. 

Audio 
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Audio objects allow you to insert audio files and narration into your slides. Audio can be 
played back during editing and is played during slideshows. 

To add audio to your slide, click the Add Audio button on the toolbar. Clicking the button 
will open the Audio from file  dialog, or you can select to insert a file or record narration 
from the button's menu. Selecting Audio from file  will open a file browser where you can 
select an audio file from your media. Selection Record Audio will open a recording window 
where you can record your narration (See: Audio Record Dialog). You can play an audio 
object by right-clicking it when it is selected. See: Audio Play Dialog 

Video 

Video objects allow you to insert video files into your slides. Video can be played back 
during editing and is played during slideshows. 

To add video to your slide, click the Add Video button on the toolbar. You can play a video 
object by right-clicking it when it is selected. 
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Concepts - Slide

A slide is a page that consists of objects. However, it is different from normal pages because it 
is based on a template and a layout so that users can easily make slides' style consistent. 
Also, Slides are only source of slideshow. 

18



Concepts - Slide master

Slide masters are special slides that are templates of namely slides. It consists of two 
categories of objects: placeholders and non-placeholders. 

Placeholder  

Placeholders can provide format information, like position, size, color and so on, for objects, 
such as text, pictures, audio, and more. The format settings of placeholders are possibly 
inherited by slides, but their contents are not inherited. If a placeholder is with no-line style and 
empty, it has a dotted border. Different preset layouts provide different placeholders. 

Non-placeholder  

Non-placeholders are normal objects on slide master or layout. They will be regarded as 
background graphics of their derived slides, so they are read-only and not allowed to select on 
the slides. However, you can play audio and video objects during slideshow. 
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Concepts - Transition

A slide transition is a motion effect which occurs from the previous slide to the current one 
during a presentation show. 
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Dialogs - Preset Layouts

This dialog defines various preset layouts to expedite presentation creation. A preset layout 
provides a higher-level description of the content type and positioning of placeholders to an 
arrangement of content on a slide. Each preset layout except Blank contains more than one 
placeholder, each with a specific content type. Express Points Presentation Software provides 
the following preset layouts: 

● Title Slide
● Title and Text
● Blank
● Title and 2-Column Text
● Title, Text and Media
● Title, Text and Content
● Title, Media and Text
● Title, Content and Text
● Title and Content
● Title Only
● Content Only
● Section Header
● Title and 4 Content
● Title, Content and 2 Content
● Title and Content over Text
● Title and Content with Caption
● Title and Picture with Caption
● Title and 2 Content
● Title, 2 Content and Content
● Title, 2 Content and Text
● Title and 2 Content over Text
● Comparison
● Title, Text and 2 Content
● Title and Text over Content

If the preset layout is set for a new slide, a new slide will be added when you click a preset 
layout. 

If the preset layout is set for already created slide(s), the layout will be applied to the selected 
slides when you click a preset layout. 
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Dialogs - Rich Text Editor

Rich Text Editor 

Rich Text Editor provides powerful text editing capability based on standard rich text control. 
When you double-click a text object or right-click popup menu, it will pop up to allow you to 
modify the selected text object on your slide. 

Bullets  

This pull down will display a selection of bullets that can be applied to the selected text 
object. 

Increase Indent  

It allows you to increase the left indent level of the whole paragraph selected currently. In 
the title, only one indent level can be set; in the text body, you can set nine indent levels. 

Decrease Indent  

It allows you to decrease the left indent level of the whole paragraph selected currently. In 
the title, only one indent level can be set; in the text body, you can set nine indent levels. 

Paragraph Spacing  

You can set paragraph spacing after the selected paragraphs. 

Left Alignment 

The text is aligned along the left margin in horizontal direction if you select this option. 

Center Alignment 

The text is aligned to neither the left nor right margin; there is an even gap on each side of 
each line in horizontal direction if you select this option. 

Right Alignment  

The text is aligned along the right margin in horizontal direction if you select this option. 

Font 

This pull down will display a selection of fonts current available on your system that can be 
applied to the selected text object. 

Font Size  

You set font size in points that can be applied to the selected whole text object. 
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Bold, Italic and Underline  

Clicking these buttons will apply the typical bold, italic and underline font styles to the 
selected text object. 

Text color 

Clicking the colored box on the right will open a dialog where you can select the color for 
the text. 

Edit text field 

You can type text into this field in a similar manner to how you would type into any text 
editing program. You can select, cut, copy, and paste using standard short-cut keys. Also, 
you can undo and redo using standard short-cut keys. The text that is entered here will be 
displayed within the draggable borders of the text object on your slide. 

Please note: if any of the text properties is changed in the rich text editor, the selected text 
object on your slide will not follow the format settings in the slide master any more. 
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Dialogs - Color Scheme Dialog

When you want to custom a color scheme like clicking Custom Color Scheme... , the color 
scheme dialog will open. In this dialog, you can set twelve scheme colors which are referred to 
as a color scheme. A color scheme consists of two dark colors, two light colors, six accent 
colors and a color for each of a hyperlink and followed hyperlink. 

Dark text/background color 1 

Set and represent the first dark color.

Light text/background color 1  

Set and represent the first light color.

Dark text/background color 2 

Set and represent the second dark color.

Light text/background color 2  

Set and represent the second light color.

Accent 1  

Set and represent the accent 1 color.

Accent 2  

Set and represent the accent 2 color.

Accent 3  

Set and represent the accent 3 color.

Accent 4  

Set and represent the accent 4 color.

Accent 5  

Set and represent the accent 5 color.

Accent 6  

Set and represent the accent 6 color.

Followed Hyperlink 
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Set and represent the followed hyperlink color.

Hyperlink  

Set and represent the hyperlink color.
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Dialogs - Position and Size Dialog

This dialog is used to show and set the values of position, size, rotation and other parameters 
of the selected object. Although you can use mouse-dragging to change the position, size and 
rotation, it allows you to do in a precise way. 

Position 
This determines the position of the object relative to the top-left of the slide.

Size 
It gives the current dimension of the object in local unit.

Original size  
It shows the original width and height of the object in local. This is only for images. If it is valid, 
you can click Reset button to reset current size of the object to the original one. 

Rotation 
It determines the rotation angle of the object in degrees.

Lock aspect ratio 
It determines whether the aspect ratio of the object is locked. If this option is checked, the 
aspect ratio will be kept when you resize the object using corner-dragging handles. In addition, 
you can keep its aspect ratio when you hold SHIFT  key during resizing the object even if this 
option is not checked. However, if you use middle-dragging handles to resize the object, this 
option does not take effect. 
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Dialogs - Add Narration Dialog

When you select Record Narration from the Add Audio button on the toolbar, the Insert 
Narration dialog will open. Once you are finished recording your narration, click the Add  button 
to add it to the current slide. 

Capture from 

Select the microphone you're using from the drop menu.

MP3 Settings 

Click this button to configure settings for the recording. Narrations are recorded as MP3 files.

Recording Controls 

Click the red record button to begin recording. Click the stop button when you are finished. 
Play back the recording by clicking the play button. The pause button will pause both a 
recording or playback.
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Dialogs - Sound Play Dialog

This dialog is a small pop up window that allows you to play your audio when you edit or show 
your slide. It will open when you select an audio object and select Play Audio from the 
right-click menu in the slide editor. In slideshow mode, this dialog can be opened by clicking 
the audio object. 
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Dialogs - Transition Duration Dialog

This dialog allows the user to set duration time of the transition effect and how to advance to 
next slide. 

Transition Type  
You can choose a transition type from more than 20 transitions. This option is not showed 
when you click a specific transition to open this dialog.

Duration 
This determines the transition time in second.

Advance Slide by Mouse Click 
This determines whether mouse click is allowed to advance slides.

Advance Slide Automatically after  
They specify whether auto-advance occurs and how long slideshow will auotmatically advance 
to next slide in seconds after the transition effect finished.

Apply  
Apply the transition with the duration to current selected slides.
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Dialogs - Reset Unsupported Transition Dialog

Some transitions are not supported on some systems so that they will be ignored during 
slideshow. This dialog will pop up before slideshow if some transitions used in the presentation 
are not supported. You can make a choice whether they are reset to another supported 
transition. 

Unsupported transition list 
Show what unsupported transitions are used in the current presentation and what slides use 
them.

Reset them as  
Allow you to specify whether the unsupported transitions are reset to another supported 
transition.

Duration 
This determines the transition time in second.
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Dialogs - Page Setup

A presentation can have only one page size and orientation (either landscape or portrait). The 
Page Setup dialog allows you to change the page size and orientation of all slides in the 
presentation. 

Slide Size 

You can select a popular slide size or set a custom slide size. 

Slide Width 

It presents the width of the slide. You can also change it. 

Slide Height  

It presents the height of the slide. You can also change it. 

Slide Orientation  

You can change all the slides in your presentation to orientation you want. Switching 
orientation will swap the width and height of the slides. 
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Dialogs - Print/Export Preview

The print preview dialog shows what your final project should look like. Open the Print Preview 
dialog by clicking Print from the Home tab toolbar, or select Print from the File tab menu. 

Print Preview  or Preview for Exporting PDF 

The print preview dialog shows how your printout will look. You can use the page buttons, 
which include Go to the first slide, Go to the previous slide, Go to the next slide and 
Go to the last slide  to go to any slide to preview it. 

Ouput Properties 

This is the information displayed in the sidebar of the Print Preview window. It includes settings 
for printing. 

Ouput Layout  

You can get different printing layouts using this option: slides or handouts: 
Slides:  One slide per page with original size. 

Handouts:  One, two, three, four, six, or nine slides on a page in horizontal or vertical 
order. In this way, your audience can use to follow along as you give your presentation 
or keep for future reference. 

Note: The three-slide handout includes horizontal lines on the right or bottom of slides so 
that your audience can use them to take notes.  

Paper Size 

Generally the size of the slide is not the same as paper size, so the paper size label allows 
you to select a suitable paper size to print your presentation documents. 

Paper Orientation  

You can this option decides the paper orientation in handout printing mode. For Slides 
mode, it is the same as slide orientation. 

Paper Margin  

The horizontal margin is used to decide left and right margins of the paper. The vertical 
margin is used to decide top and bottom margins of the paper. 

Note: These margins are only for handout printing.  

Show Frame on Slides 
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When this is checked, a black frame will be added when printing to show the border of 
slides. 

Print Hidden Slide 

You can use this option to tell Express Points Presentation Software whether to output 
hidden slides. 

Print... in the Print Preview  dialog or Export...  in the Preview for Exporting PDF dialog 

The Print... button in the Print Preview  dialog will launch your system's print dialog, where 
you can select the printer that you will be printing to, and any additional properties for this 
printing job. 

You can export the presentation to a PDF file according to settings in the preview dialog 
using the Export...  button in the Preview for Exporting PDF dialog. 
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Options - General

The Options dialog allows the user to specify certain Express Points Presentation Software 
customization preferences. 

Show Welcome dialog when the application starts 

This check box determines if the Welcome dialog to Express Points Presentation Software is 
shown each time you open the program. 

Units  

This determines the display measurement units used by all controls within Express Points 
Presentation Software. 

Target slideshow device : The Options dialog allows the user to specify which display device 
is used for slideshow when you have multiple display devices. 

This determines which display device is used for slideshow. The default option is Auto, which 
means Express Points Presentation Software will automatically select a display device based 
on the ratio of slides and display devices to get a matched display. 

34



Panels - Main Window Panels

Fill Properties Panel 

In this panel, you can set the fill properties of the current selected object or the background of 
the current slide. Fill properties panel. 

Line Properties Panel  

This panel serves to set line style of the current selected object. Line properties  panel. 

Color Scheme Panel  
See: Color Scheme panel. 
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Panels - Fill Properties

Fill Properties Panel 

This panel contains fill properties of the object that is currently selected. It will show the 
properties of the slide background if there is no objects selected. 

No fill  

The selected object does not have fill effect if this fill type is set. It can make an object 
transparent or colorless. 

Solid fill  

To add color and transparency to an object, click this option and select a color by clicking 
the color box to open the color picker. 

Gradient fill 

To add a gradient fill to an object, select the Gradient fill radio box. A gradient is a gradual 
progression of colors and shades, usually from one color to another color, or from one 
shade to another shade of the same color. You finish a gradient fill setting as follows: 

● Select the type of gradient that you want from the Gradient fill drop menu.
● Drag the arrow in the direction you want to set the gradient at in the Direction pane.
● Click the Stops  bar to add gradient stops. Stops are color points for the gradient. 

The current stop color highlighted with a blue triangle can be selected or deleted 
from the Stop Point  control, and the opacity sets the stop transparency. Also you 
can move or remove gradient stops until you have a stop for each color that you 
want in your gradient fill.

When you customize the gradient fill, you can see the effect on your selected object. 
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Panels - Line Properties

Line Properties Panel  

This panel contains line style properties of the object that is currently selected. It will show only 
when an object is selected. 

No line  

To make lines of an object transparent or colorless, choose this option. 

Solid line  

To get solid color lines for objects, set this line type. 

Gradient line 

To add a gradient line to an object, select the Gradient line radio box. A gradient is a 
gradual progression of colors and shades, usually from one color to another color, or from 
one shade to another shade of the same color. You finish a gradient line setting as follows: 

● Select the type of gradient that you want from the Gradient line drop menu.
● Drag the arrow in the direction you want to set the gradient at in the Direction pane.
● Click the Stops  bar to add gradient stops. Stops are color points for the gradient. 

The current stop color highlighted with a blue triangle can be selected or deleted 
from the Stop Point  control, and the opacity sets the stop transparency. Also you 
can move or remove gradient stops until you have a stop for each color that you 
want in your gradient fill.

When you customize the gradient line, you can see the effect on your selected object. 

Line width 

Specifies the width of the lines in point size. 

Dash type 

Specifies line type from the drop down list: Solid, Dash, Dot, Dash Dot and Dash Double 
Dot. 
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Cap type 

Specifies cap style of the lines. 

Join type 

Specifies the line join style. 
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Panels - Color Scheme Panel

Color Scheme Panel  

This panel contains a collection of color schemes. Each color schemes defines a set of colors 
including twelve colors. The twelve colors consist of six accent colors, two dark colors, two light 
colors and a color for each of a hyperlink and followed hyperlink. Note: It is only for master 
slides. 
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Slideshow - Slideshow

Slideshow presents your slides to audience with full screen mode. You can mark on slides 
using pen and highlighter during the slideshow. If you have two display devices (one monitor 
and one projector), Express Points Presentation Software also show presenter window to give 
you more information(e.g. current time, elapsed time and what is next slide). You can use 
right-click popup menu to turn over between slides on the screen for audience. There are more 
controls on the presenter window. In addition, you use keyboard to do frequent operations. 

Slide turnover 
Next slide : You can go to next slide using the following ways: 
Right-click popup menu Next on the screen for audience; 

Click button Next slide  on the presenter window; 

Hit any key: space, Page Down , Arrow Down, Arrow Right. 

Previous slide : You can go to previous slide using the following ways: 
Right-click popup menu Previous on the screen for audience; 

Click button Previous slide  on the presenter window; 

Hit any key: Page Up , Arrow Up, Arrow Left.  

First slide : You can go to the first slide using right-click popup menu First slide  on the 
screen for audience or Home  key. 

Last slide: You can go to the last slide using right-click popup menu Last slide on the 
screen for audience or End key. 

Mark on slides: You can use pen or highlighter to draw some marks on the current slide to let 
your audience focus on some important contents on the slide. The marks are kept during the 
slideshow, but they are automatically cleared after you exit your slideshow. Right-click popup 
menu Pointer Options on the screen for audience to select the following pointer type and 
color: 

Arrow : It is a default pointer that cannot draw marks on the slide. 

Pen : It can draw thin lines on the slide like a normal pen. The pen color is red by default. 

Highlighter : It can highlight some contents on the slide like a highlighter. The default color 
of the highlighter is yellow. Please note: There is no marks left on the slide if you select ink 
color of the highlighter as white according to the highlighting algorithm. 

Ink Color: You can use it to select a color as the color of your pen or highlighter when the 
pointer is pen or highlighter. 

Clear slide marks : You can delete all ink marks on the current slide during the slideshow if 
you want. 
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Exit slideshow: You can use the following ways to exit current slideshow if you want to end it. 

Right-click popup menu End show  on the screen for audience; 

Click button Exit slideshow on the presenter window; 

Hit Esc key. Please note: The first Esc will just reset the current pointer to "Arrow" if the 
current pointer is not "Arrow". 

Pause/Resume timer button on the presenter window allows you to pause the timer if you 
want to have a break and to resume it. 

Exchange display button on the presenter window can exchange slideshow between display 
devices. 
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Screen References - Custom Resolution

This dialog allows you to set up the resolution for your video during saving. To set a custom 
resolution, click the Save button on the toolbar and select the Disc: Make Data Disc, 
Computer/Data, Portable Device, Image Sequence, or Stereoscopic 3D options. From the 
Resolution drop menu, select Custom.

In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
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Screen References - Custom Frame Rate

This dialog allows you to set up the frame rate (number of frames per second) for your video. 
To set a custom frame rate, click the Save button on the toolbar and select either of the Disc: 
Make Data Disc, Computer/Data, Portable Device, or Stereoscopic 3D options. From the 
Frame Rate drop menu, select Custom.

In the Custom Frame Rate dialog that opens, input the frame rate and click OK.
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Screen References - Detected Format

This dialog shows you the detected format of the video sequence during the saving process. 
To detect the format or your video, click the Save button on the toolbar and select either of the 
Disc: Make Data Disc, Computer/Data, Portable Device, or Stereoscopic 3D options. Click the 
Detect button next to the Preset field.

If you want to use a different format you can select the format from the Preset drop-down list.

Click OK to use the selected format as the output format.
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Screen References - DVD Bitrate Settings

This dialog allows you to specify bitrate for your DVD video. To open this dialog, click the Save 
icon in the toolbar and select the Disc save option and click the Make DVD Movie option. Click 
the Advanced button to open the DVD Bitrate Settings dialog.

The default option is to calculate the bitrate automatically. To set the bitrate manually, select 
the manual option and adjust the video and audio bitrates.
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